


Using Photoshop Elements

Photoshop Elements (PSE) is a slimmed down version of Adobe Photoshop (PS). Photoshop is
a photo and image editing software that experts and graphic designers might use to edit photos,
while PSE is a program that anyone can use to help edit photos and create, edit and share
images. It has most of the features of PS but in a simpler format so that they’re easier to use
and understand. Plus, you can buy it for about $100.00.

With PSE you can create and edit images in many formats. Plus, you can easily share your
photos and videos with anyone, from anywhere if you set up your Organizer’s Mobile settings.
Images will be stored in the cloud for you to use and edit anytime you need them. You can even
share them to social networks, create private albums and more.

If you are familiar with older versions of Photoshop Elements here is a list of the new and
improved features in Photoshop Elements 12.

 Content-aware Move – You can actually move an image, like a person into the shot
easier using more automated features. Did your two year old run off before you got the
right picture? Just move him right on into the shot.

 Auto Smart Tone – If you use skin tones a lot, PSE will remember the tones you use
most often and give you the right choices.

 Enhanced Quick Edit Mode -- In the QEM you can do a lot of things easily without
opening the full version of PSE such as whiten teeth and fixing red-eye or pet eye.

 Greeting Card Printing – Easily send your finished product to a printer to have them
professional created just for you.

 New Guided Edits – Even more help for the inexperienced. If you’re not sure what you
can do with a particular image, just choose the Guided feature and let PSE help you
through it.

 Content-aware Fill – Do you have a picture that’s a little off balance? You can fix those
crooked photos easy without messing up your image.

 Pet Eye – Just like people have “red-eye” in photos, pets can have a pet eye effect, fix
those easily now.

 Social Media Sharing – You can now share with social media, email and other ways
right from the editor.

 Revel Albums in Editor – Want to choose a picture from the editor to use? Just look
through the albums right from the editor making it easier than ever to find the right photo.

 Open in Camera Raw – Easily process freshly taken pictures before you even open the
editor.

All those new features may seem a little overwhelming but the way PSE lays everything out is
intuitive and easy to understand. Plus if you don’t understand something you can try the Guided
features.



When you first install and open PSE you’ll see a window like this:

From this window you can access either the Organizer or the Photo Editor.

The Organizer

The organizer is used to manage and organize all your photos, images, audio and videos.
Inside organizer you can tag photos which make them easier to find. Organizer doesn’t change
the files at all; it’s just a place to store images until you want to use them in some way either by
sharing or editing. Unless you’ve created a mobile album the files are stored on your computer
but accessed and organized with the PSE Organizer.

Inside the organizer you have many choices about the information you can add to any given
image to make them easier to locate. For example files can be organized by place, people and
events as well as when and where the file was created. This makes it easy for you to find the
right files when you need them. Plus, you can open them to edit them in PSE from the
Organizer.

To get started, click the green plus sign to import images from files you have on your computer.



Once you have images inside an album you can then tag and organize them.

Using the Organizer is optional. You do not have to import images before using Photoshop
Elements. You can open images from anyplace to edit. The Organizer is simply a place to keep
images organized.

Since the Photo Editor is what most people want to know how to use, that’s what this report
focuses on. So let’s get started.

Photo Editor

In this report you’ll learn about some of the most useful features of the photo editor in PSE
including how to edit images to add layers, objects, text and effects as well as how to edit
images of people.

Learning these basic features of PSE will enable you to create many useful graphics for yourself
without spending a lot of money for a graphic designer. In addition, you will know how to
properly save your images to turn over to a graphic designer to polish up and finish your design
ideas.

The Basic Features of Photoshop Elements

It doesn’t matter how new you are to editing images, you can use PSE without much training.
PSE helps you every step of the way. First, PSE starts with three basic choices depending on
what you want to do.

Quick -- You can use this selection if you just need to do something simple like crop, add
something quick like text to an image or a few other special effects such as fix red-eye, or even
change the hue and saturation of a particular photo.



Guided – This is what it sounds like. If you need some extra help with the photo editor, the
guided area is what you should use.  For instance, let’s say you want to crop an image. If you
choose your image, then choose Guided, and then choose Crop. You’ll get an image that now
looks like this:

Notice the grid that appears over the image, and then on the right the crop box size and overlay
choices. There you can choose how large you want the crop to be and learn about the rule of
thirds which is an important design theory. So, not only can you crop your image, you can learn
what professional designers understand about layout and space.

Expert – When you click Expert all the tools available open up to you including layers, selection
tools, cropping tools and other transformative tools without restrictions and without additional
help as in the example above.



For this tutorial we are going to use the Expert edit feature. You are highly encouraged to get
the 30 day free trial and give the quick and guided features a try on your own.

When you open the photo editor you’ll see a lot of information in the workspace that opens.
There are choices at the top, bottom and sides. The best thing for you to do is click around and
become familiar with the different choices available to you in the workspace.

This is the “expert” workspace view without any of the choices activated. If you click on anything
you’ll see more choices.

Some choices will not activate unless you open an image in the workspace. In order to get
started right away using PSE there are some important features to learn.

One of most important aspects of editing images is how to use layers. Learning how to use
layers will open up a whole new world of photo editing for you, allowing you to create
professional looking images far beyond other methods.

Photoshop Elements Layers

Layers are one of the hardest concepts to learn when it comes to editing photos and images.
But, it’s one of the most important aspects of PSE for you to learn because the concept of layers
will allow you to edit various elements easier than if you have just a flat image. Editing flat
images without layers actually destroys the original image. Making changes once you’ve applied
an effect is a lot harder, if not impossible, without layers.

Because using layers is so important, we are going to talk about it first even though it’s one of
the more difficult concepts to grasp. Because layers can be visible or invisible as you wish,
knowing about how they work will make it easier to change one thing on the image you’re
making. Once you understand it, you’ll be able to do a lot using PSE.

For instance, let’s say you are making a banner for your sales page, if you save it in PSD format
(the format that saves layers individually) you’ll be able to open the image again, adjust just
what needs adjusting, and then save it again in the format you want to use such as PNG or
JPG. You won’t have to start from scratch each time, making the entire process a lot easier.



You can use the basic set up such as the color scheme, text style, images and so forth in every
banner you create without having to start from scratch.

Best Practices

Before we begin, let’s discuss a few best practices when using Photoshop Elements. These
best practices will help you avoiding time wasters and frustration.

 Save Your Work Properly -- When you are pleased with your image first save a copy of
your work in PSD format. Then you can save a separate copy in the format needed for
your project be it JPG, PNG or another format. If you want someone else to work on the
image using PSE or PS you should provide them the PSD file rather than another
format.

 Learn About Image Formats -- PSD, TIFF, PNG, JPG, are all different image formats.
PSD is the only way to save an image for editing within Photoshop elements or
Photoshop with all the layers still editable. TIFF is another way to save a very high
quality digital image that you want to print out or edit later. PNG files are used often
online because it supports transparencies. JPG or sometimes JPEG is fine for printing
images but if you compress too much the quality is eroded. Take the time to learn which
format will work best for the project you are working on.

 You Can’t Break It – As long as you don’t change the original image you can’t mess
anything up. Before you start editing, create a working copy so that you always have a
original ready to use.

To do this, when you first open your image, it will be named “background”. On the right
sidebar of PSE you’ll see a thumbnail of the image. Simply right-click this thumbnail and
create a copy. Then close out the original “background” image so you don’t accidentally
mess it up.

Let your imagination go and don’t worry. You can’t break Photoshop Elements.

Working with layers is the best way to preserve your original image, and get the results that you
want. Before any further ado let’s go over layers. Once you master layers you can easily apply a
lot of other features of PSE.

Let’s start with something simple. As you see below, this is an image brought into PSE of white
and pink flowers. Go to File > Open, and then find the image like you would for any other
program. Select it to open it.



Using layers you can change many things about this photo. For instance, let’s say you don’t
really like the color of the flowers. You can use layers to adjust this easily without being stuck
with the choice or starting an entirely new project.

Using Layers to Change the Color of an Image

Click on the blue and white circle icon “create new fill or adjustment layer”.

Click the drop down arrow to reveal all the choices.



For this image we are going to choose “Hue/Saturation” in order to create a layer that will allow
us to play with the color choices of this flower.

After choosing Hue/Saturation, you’ll get a new window giving you a slider to change the colors
of the origional photo.

Don’t worry, when working with layers no change is permanent. You can easily turn them on
and off and even delete them without affecting your origional image.

These controls enable you to control the color saturations. Just play with the controls until you
get the color you are looking for. With just a few slides of the hue, saturation and lightness,
we’ve changed the color to blue.



Adding an Object

By adding more layers you can also add new objects into the photograph. On the top right side
of the workspace you’ll see an icon that lets you add a new layer.  “Create a new layer”. It looks
like a piece of paper.

Just click it as many times as the number of layers you want to create. To work on a specific
layer click the layer to activate it so you can make your changes.

In the picture above you see various layers such as the background layer, our first white flower
picture, then the Hue/saturation layer, and various other layers. Choose one of the new layers to
activate it and change its name. We named ours “bumblebee”. This makes it easier to know
which layer to alter or turn off or on later.

Let’s add an object. This cute bee will work.



Open the new picture in the work window. Don’t worry; your other work is still there, just click
the layers icon to see it.

View with layers icon selected.

The bee is a good choice, but the white back ground needs to be removed. In order to
accomplish that, use the selection tool. Since the bee is on a white back ground it’s not too
difficult.

Click the selection tool.



This will reveal, at the bottom of your workspace, all the choices available for selection tools
including the “magic wand” tool which is the one we want to use.

Click the magic wand, and then highlight the back ground by simply holding down the shift key,
and pointing and right clicking on the white back ground until all the flashing highlights surround
the entire bee.

Then, go back up to the top of the workspace, and at the top menu choose “select” and then
“inverse”.

What this does is select the bee instead of the back ground. If you used this method without
selecting “inverse” you would paste only the back ground of your image into the blue flower
instead of the bee.



Now copy and paste the image into the blue flower.

That choice is under the Edit menu item. First choose copy.

After you’ve copied it, highlight to activate and select the image you want to copy it into by
choosing layers, then highlighting the picture you want to paste the object into on the bottom
where the different layers appear.



If you notice above the blue flower has a blue outline to it now, which shows that it is selected,
plus it shows up in the workspace once selected. The bee image has been copied and is on the
clipboard all you do now is paste it.

Click paste.

When you click paste the bee will go into the center of the image.



The bee looks kind of cute there, but now that it’s there we can move it around and place the
object, in this case a bee, exactly where we want it to appear in the image.

To move the object: Choose Image > Transform > Free Transform

Next, click on the bee to activate it. A square will appear around it. Drag the picture to where
you want it to go.



Once you’ve dragged the object where you want to go, click the green checkmark.

Now you have a sweet little bee poised to pollinate your flower.

Notice that the hue/saturation performed on the white and pink flower does not affect the new
bee layer. The bee remains the color it is was before pasting it into the blue flower picture.

In addition, you can turn on and off various layers without affecting another layer. Notice that to
the left of every layer is an “eye” icon, this is used to turn each layer on and off. By clicking the
eye you can turn on and off that layer anytime you want to.

A red line is through the eye means that layer is turned off. No red line means that layer is
visible



A layer that is highlighted in blue is the active layer that you are currently working on. By turning
off the Hue/Saturation layer the flower will go back to the original color, but the bee is still there.

The ability to turn on and off and delete layers is what makes layers so useful.

Reminder: If you remember to save your work in PSD format you can come back and make
changes any time you want to the image. This is very good time saving tip.

Using Layers to Add Text to an Image

To add text to the image, create a new layer, and then click on the layer to activate it. On the left
hand side of your workspace click the T.

On the bottom of the workspace, you will now see controls that allow you to adjust the font, size,
layout, color and so forth of the text.



To add the text, click on the picture and drag a text box where you want the text to appear.

Click the curser inside the text box and start typing.

Use the controls at the bottom of the workspace to control the size, style, color and layout of the
text by highlighting the text that you typed first, then changing the information.

If you need a text size different than what is pre-set by PSE in the drop-down, simply type in the
size you’d like to use.

Use a new layer for each new text group that you want added to your image; when the size and
shape is right click the green arrow.

Click on the text within the image to drag it around to other areas on your image to see which
placement you like best. Once you find the right spot, click the green check mark. Here’s the
image with the hue/saturation layer turned back on.



Using Layers to Add Effects to Images

Now that your image is almost complete, you can use layers to add some additional special
touches to the image using effects.

First, create a new layer by simply clicking the “create a new layer” icon. Remember, it looks like
a piece of paper. Then click the new layer to activate it, give it a new name, and then at the
bottom right of the workspace choose FX effects.

You’ll get a choice of effects. You can show all of them, or you can only show the ones you
choose such as frames, misc. effects, and so forth. Since you chose to apply effects within a
layer you can feel free to experiment to see what happens.



You can turn on and off the layers to add or subtract effects to figure out what you like.

Let’s do some effects in a new image just to see what happens.

This time we’re going to use a red flower and the “rubber stamp” effect.

Here’s one more using the “photocopy” effect.

The best way to figure out how each effect will affect a particular image is to simply try them.
Remember to copy the original image and so you do not apply the effects to your original image
or you will destroy it.



Editing Images of People

One of the reasons most people like to use a photo editor is to edit people. PSE has some auto
edit features. Just open up the image you want to edit, remember to use a copy of the image so
that you don’t mess up your original image.

You can put the image in and choose before and after so that you can immediately see what
happens to the image as you change things about it. Under “guided” you will get some prompts
and help and more information about your choices.

Get a Tan

Everyone likes a natural looking tan. So even if you’re ghost white, your selfies can have a
warm, natural glow.

Remove Wrinkles

Wrinkles are something most people would like to remove from their pictures. With PSE, you
can smooth away some of those to make you look younger.



Whiten Teeth

And who doesn’t wish for whiter teeth? Under the “quick” option there is an easy way to whiten
your smile; it looks like a tooth brush.

While this report has shown you the basics, there is so much more you can do with PSE. The
best way to learn it is to jump right in and try new things. Before you know it you’ll be an expert
at using Photoshop Elements to edit, organize and share all your images for business and
personal use.



Using Photoshop Elements to edit images, banners, and more is actually pretty simple once you
lose the fear and get started. Try out different features, and don’t forget to try the guided feature
as well. It will give you some great ideas for what you can master yourself.

Photoshop Elements is a fun and easy way to make all your images easier to find and look
better too. You can do simple to complex designs with PSE. While not as feature rich as the full
version of Photoshop, Photoshop Elements will help you take care of anything but the most
advanced methods of photo editing. It costs a lot less than Photoshop and it is much easier to
use.

In PSE you can:

 Create Website Banners
 Create Memes
 Create Infographics
 Edit Family Photos
 Create Book Covers
 Use Layers to Edit Images
 Fix Red Eye
 Whiten Teeth
 Fix Pet “yellow” eye
 Add Objects into Images
 Add Frames to Photos
 Create Slide Shows
 Share Images with Others
 And so much more …

There honestly isn’t much that Photoshop Elements can’t do with your images. Unless you are a
professional creating magazines or specialized layouts PSE will be full-featured enough for your
needs at a price that most people can afford. With Photoshop Elements you’ll be able to create
web banners, photo albums, slide shows and more.
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